Building a Home vSphere Lab —Part 1

September 26, 2015

Introduction
One of the questions asked most often by vSphere enthusiasts is: “what’s the best way to build a home vSphere lab?”
Realistically, there are only two answers to this question:

e Get on EBAY and buy one or two generation old server hardware that’s still on the VMware HCL:
http://www.vmware.com/go/hcl.

e Use VMware® Workstation™ Pro to build a virtual vSphere home lab.
Nothing replaces the overall experience of building vSphere on real, physical server hardware! There are just certain
things you can’t do with virtual (nested) installations of ESXi like: RAID, IPMI and DPM. Using real server hardware,
however, is just not practical for any number of reasons:

Your wife will hate you.
Your power bill will go up by hundreds of dollars per month (no kidding!)!
Your cat will think you have installed an always-on vacuum cleaner.

PN PR

The minor ego-boost you get from showing-off “real servers” will be far outweighed by the looks of pity on the
faces of most good-looking women, whose only thought will be: “what a dork”!
5. As a minor offset to the disadvantages of running physical servers at home, is that you could (and | have) heat
your house with them in the winter!
Virtual vSphere labs provide a great deal of flexibility and an awesome learning platform, without increasing your
power-bill by $500+/month (no kidding!).

The Backstory

Many years ago, when ESX ran on top of RHEL, | created my own lab(s) on what amounted to junk. Because RHEL
bootstrapped the hypervisor (vmkernel), and the Service Console was 32-bit, not only was ESX compatible with a wide
variety of hardware and storage, but the resources actually required were tiny!

In the day, | used just about any POS personal computers available, converted the IDE storage to SCSI with nifty little
gizmos that plugged into the back of the drive, and Voila, | had created a viable ESX server from just about anything!
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Things changed when VMware shifted from ESX to ESXi and the platform no longer ran on top of RHEL. First and
foremost, ESXi was now exclusively 64-bit. You could no longer get away with 32-bit hardware by only building 32-bit
Operating Systemes; just to create a Whitebox ESXi server, you had to begin with a 64-bit capable system. Another
challenge was storage and networking. Whereas ESX on RHEL had supported just about anything, ESXi had a finite list of
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supported adapters and would refuse to install if one of those was not present. Given the era ESXi became available,
around 2008, 64-bit capable systems and supported adapters were still somewhat pricey and creating successful
Whitebox labs became less viable.

Fortunately, along with ESXi came support for nested hypervisor installations. This had been previously possible, but
only by going to great lengths and tricking the host hypervisor (usually VMware Workstation) and the guest hypervisor
(ESX, at the time) into believing that they were physically hosted.

Somewhat concurrent with the initial release of ESXi, VMware added native support for nested hypervisor installations
to VMware Workstation, and building a viable virtual vSphere home lab became a real and affordable possibility!

How are we going to do this?

In an orderly fashion, | hope.

What sort of a system will I need?

In order to build a viable home vSphere lab on top of VMware Workstation Pro, you are going to need a reasonably
powerful PC. Don’t even mess around with vSphere unless you have at least 16 GB of RAM on a multi-core CPU capable
of Virtualization.

= o =)
——
SIAY) |_'Bi < All Control Panel Items » System - |$?| | Search Control Panel 2 |
@ -
Contral Panel Home . - . -
View basic information about your computer
) Device Manager Windows edition
Bl =me ciling= Windows 7 Ultimate N
[ System protection Copyright © 2009 Microsoft Corporation. All rights reserved.
'?:B' Advanced system settings Service Pack 1 |
System
Rating: System rating is not available
See also Processor: Intel(R) Core(Th) i7-2720QM CPU @ 2.20GHz 219 GHz
Action Center Installed memory (RAM): 320 GB
Wind Undat System type: 64-bit Operating System
indows Update
X Pen and Touch: Mo Pen or Touch Input is available for this Display
Performance Information and
s Computer name, domain, and workgroup settings

My own personal system is several years old, but more than up to the task, and a check of the Intel website confirms
that my processor is capable of Virtualization.

Intel® Virtualization Technology (VT-x) ¥

Intel® Virtualization Technology for Directed I/O (VT-
dj*

Intel® VT-x with Extended Page Tables (EPT) Q

Intel® 64 ¢ Q

Intele My WIFi Technoloey
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Before even beginning, you will want to reboot whatever workstation you will be using and make sure that Virtualization
in enabled in the BIOS. If it is not, enable it now. Ask your best friend Google what keystroke or combination is required
for your model PC or motherboard to access the BIOS boot menu.

& bios keys hp elitebook - C %

€ = C | @ https//www.google.com/?gws_rd=ssl#

Go g[e bios keys hp elitebook

Internal Graphics Mode [Disabledl
UMA Frame Buffer Size 128MB
Surround View Disabled
Onboard UGA output connect D-SUB/DUI
Init Display First [PEG]
Uirtualization [Enabled]

AMD K8 Cool&Quiet control [Autol

Hard Disk Boot Priority [Press Enter]

First Boot Device [Hard Disk]
Second Boot Device [USB-HDD]
Third Boot Device [CDROM]
Password Check [Setupl

HDD S.M.A.R.T. Capability [Enabled]
Away Mode [Disabled]
Backup BIOS Image to HDD [Enabledl
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Part 1 - Installing VMware Workstation Pro and VMware ESXi as a VM

Getting and installing VMware Workstation Pro
VMware® Workstation™ Pro (formerly just: VMware Workstation) is available for Windows and Linux in a fully licensed
and trial version from VMware. You can contact VMsources or any other authorized vendor to purchase VMware

Workstation Pro once your trial expires.

1.

Page 4

Download Workstation

fﬂ Try VMware Workstation P... x\+

(=S M =

€ | ¥ & wwwvmware.com/products/workstation/workstation-evaluation e || Q Search

wnwa re@ Products Cloud Services Support  Downloads

Home / Products / VMware Workstation Pro / VMware Workstation Pro Trial

VMWARE

VMware Workstation 12 Pro for Windows 64-bit

VMware Workstation 12 Pro for Linux 64-bit

VMware Technolog How To Get It Get Support

My VMware Partner Central Training Community Store

s of Workstation

o i
WORKSTATION S
p RO virtualization software offars the pe
reliability, and cutting edge feature
il Pro.

+ A e O 4o &e- =

Consulting Partner Programs Company

m

Download Now

Download Now

‘Communi 2

a. Save to a default location
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Opening ViMware-workstation-full-12.0.0-2985506. exe

You have chosen to open:

57 WMware-workstation-full-12.0.0-2985596_exe

which is: Open Virtualization Format Distribution Package (292 ME)

from: https://download3.vmware.com

Would you like to save this file?

| Save File | | Cancel

2. Run as administrator (always!)

Page 5

Name

Date modified Type Size

‘3_} VMware-workstation-full-12.0.0-2985596. 9/26/2015 7:54 AM Anolication 299121 KB

a.

Open

Next

]

Run as administrator
Troublesheot compatibility
7-Zip

ﬁl Whiware Workstation Pro Setup

YMWARE

WORKSTATION;
PRO

(o] & |uESa)

Welcome to the VMware Workstation Pro
Setup Wizard

The Setup Wizard will install VMware Workstation Pro on your
computer, Click Mext to continue or Cancel to exit the Setup
Wizard,

Copyright 1998-2015 YMware, Inc, All rights reserved. This
product is protected by U.5. and international copyright and
intellectual property laws, YMware products are covered by
one or more patents listed at:

http: /v, vmware., com/go/patents

[ Mext | [ Cancel
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b. Next
'ﬁf’l Whiware Workstation Pro Setup EI =] @ﬂ
End-User License Agreement —
Flease read the following license agreement carefully L
VMWARE END USER LICENSE AGREEMENT .

PLEASE NOTE THAT THE TERMS OF THIS END USER
LICENSE AGREEMENT SHALL GOVERN YOUR USE
OF THE SOFTWARE, REGARDLESS OF ANY TERMS
THAT MAY APPEAR DURING THE INSTALLATION OF
THE SOFTWARE.

[T accept the terms in the License Agreement!

Brint ] l Back ” Mext ] l Cancel ]
c. Next
ﬁ WMware Workstation Pro Setup EI =] @
Custom Setup L —
Select the installation destination and any additional features. |
Install to:
C:\Program Files (x8a)\WMware\WMware Workstation', Change...

This feature requires 10ME on your host drive,

Back ” Mext ] I Cancel
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d. Next

'ﬁf’l Whiware Workstation Pro Setup EI'E'@

User Experience Settings -

Edit default settings that can improve your user experience,

Check for product updates on startup
When YMware Workstation Pro starts, ched: for new versions of the application
and installed software components.

Help improve YMware Workstation Pro
Send anonymaous system data and usage statistics to VMware,

Learn Mare

Back ]| Next [ Cancel ]

e. Next

ﬁ WMware Workstation Pro Setup EI'E'@

Shortcuts - —
Select the shortcuts you wish to place on your system,

Create shortcuts for ViMware Workstation Proin the following places:
Desktop

Start Menu Programs Folder

Back ]| Next [ Cancel
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f. Install
ﬁl Whiware Workstation Pro Setup EI =]
Ready to install VMware Workstation Pro U
Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.
Back ]| Install | [ Cancel ]
g. Wait

ﬁ-‘ WMware Workstation Pro Setup EI =l

Installing VMware Workstation Pro U

Please wait while the Setup Wizard installs VMware Workstation Pra,

Status: Validating install
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h. Finish
ﬁl Whiware Workstation Pro Setup EI =] @

.

Completed the VMware Workstation Pro Setup
Wizard

YMWARE

WORKSTATION: Click the Finish button to exit the Setup Wizard.

PRO .

Press the License button below if vou want to enter a license
key now.

License
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Configuring Workstation Pro

Before building your lab, | recommend configuring the networks you will be using as you install ESXi, vCenter and any
other vSphere components you will be setting up. For a Best Practices compliant installation, you will need, at the
minimum, the following networks:

e A Management Network. This will be used for the ESXi “Management Network” vmkernel, vCenter and any of
the vSPhere API’s.

o The firewall for the Management Network will be among the most secure.

e A Server network. This is the network where Servers (VMs) like SQL, Exchange and Apache will reside. Even if
you are only building vSphere, you should create this network so you know how to separate “Management”
from other services.

o The firewall for the Server network, typically, denies all connections and has “pass” rules specific to each
hosted server and its required application ports.

e A Storage network. This is the network for iSCSI storage. Even if you plan on using only local storage provided by
Workstation Pro, you should create this network so you can practice and demonstrate Port Binding, Jumbo
Frames, and Path Selection Policies.

o The Storage network is ideally isolated, with no routes. This is also known as “air-gap network.”

We'll use the default NAT virtual network (in this example, VMnet8) as our vSphere Management Network. This network
will essentially be behind the Windows Firewall and/or any other software firewall on your PC. Although this network is
configurable, | recommend you leave it alone. As a Class C network (CIDR: /24 —or- SNM: 255.255.255.0), it has more
than enough host IP addresses to accommodate your needs. Also, in my experience, if you change the gateway IP of this
network after Workstation is installed, software firewalls may block traffic causing an apparent lack of connectivity. Even
though | personally would never place a gateway on .2, that IP is as technically valid as any other and | am going to live
with it.

We'll use the default Host-only virtual network (in this example, VMnet1) as our Server network and we will create
another Host-only network (in this example, VMnet2) as our Storage network.

Later, in a different article, | will cover how to create a Virtual Router which can secure your Server network and any
other networks you might choose to create.

1. Right-click on Edit and select the Virtual Network Editor
Whhware Workstation

File | Edit | View VM Tabs Help

Cut Ctrl+ X

for H ] o
Copy Ctrl+C |
Paste Ctrl+V

@ virtual Network Editor...
Preferences... i_trl+P
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Choose: Add Network

& Virtual Network Editor

(]

Mame Type External Connection Host Connection DHCP Subnet Address
YMnet Bridged Auto-bridging - - -
VMnet1 Host-only - Connected Enabled 192, 168.227.0
VMnetd MAT MAT Connected Enabled 192, 168.153.0
i Add Network... i [ Remove Metwork

VYMnet Information
(7 Bridged {connect VMs directly to the external network)

Bridged to: | Automatic
(71 MAT (shared host's IP address with VMs)

(@ Host-only (connect YMs internally in a private network)

Connect a host virtual adapter to this network
Host virtual adapter name: YMware Metwork Adapter YMnet1

IUse local DHCP service to distribute IP address to WMs

SubrmetIP: 192,168 .227. 0 Subnetmask: 255 .255.255. 0

o ) (om

T 2=tHnn
;"Eu \__Snu

DHCFP Settings...

Apply

i. Use the default or select a VMnet to use

Add a Virtual Network ==
Select a network to add: ['l.u'MnetE "]
QK ] [ Cancel ] [ Help ]

©John Borhek 2015, All Rights Reserved
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b. This is what the completed configuration should look like

& Virtual Network Editor (2]

Mame Type External Connection Host Connection DHCP Subnet Address

VMnetd Bridged Auto-bridging - - -

VMnetl Host-only - Cannected Enabled 192,168,227.0

VYMnets MAT NAT Connected Enabled 192,168, 153.0

VMnet2 Host-only - Connected Enabled 192,168, 159.0

[ Add Network... [Remg\fe Metwork

WMnet Information

" Bridged (connect VMs directly to the external network)

Bridged to: | Automatic Automat

A
o
A
%]

| NAT (shared host's IP address with YMs) MNAT Settin

m
[T}
[

@ Host-only (connect YMs internally in a private netwark)

Connect a host virtual adapter to this network
Host virtual adapter name: YMware Network Adapter YMnet2

Ize local DHCP service to distribute IP address to WMs DHCP Settings...

SubnetIP: 192,168 .153. O Subnet mask: 255 .255.255. 0

m I oK I I Cancel J I Apply J I Help J

Many administrators shy-away from 192.168.X.Y networks because they feel that these are somehow “armature grade”

inferior networks. Truth is that you should pick a network that is large enough to accommodate your foreseeable needs,
and no larger. Also, while Classless networks are valid, they should be used with reason. Classful networks are much
more elegant.

Since neither vSphere Management nor Servers would require more than 254 Host IP’s, except in larger installations, the
192.168.X.Y/24 networks will work just fine.

Getting vSphere
You will want to acquire binaries from VMware:

e ESXi (the VMware version, not a vendor-customized 1SO)

e The VMware vSphere Client (for Windows)

e The vCenter Server Appliance (Recommended by me) or vCenter installable for Windows

e The vCLIl, the vMA and any other utilities and extensions

e vSphere Data Protection
VMware will give you access to all of these under its trial program, all you need is a valid email address. . The trial
version of vSphere is Enterprise Plus Edition, so download your binaries from that category (in truth, ESXi and vCenter
are the same binaries for every Edition and Kit). You can contact VMsources or any other authorized vendor to purchase
VMware vSphere once your trial expires.
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Go to Downloads

IW Download VMware vSphere X\+
€ [ @ hitps;//my.vmware.com/web/vmware/info/slug/datacenter_cloud_infrastructurefvmy EJ 7 @ || Q Search 3 A& v B 4 ® & = |- =
== VIVIWaTE VREDIZE UNUTEsT SToT ApPIanice Ous ZUTIFUETO U DUWITTOaUS P
VMware vCenter Operations Manager Foundation 585 2015-03-12 Go to Downloads
v Enterprise Plus
VMware vCenter Server 6.0 U1 2015-08-10 Go to Downloads
VMware ESXi 6.0 U1 2015-08-10 Go to Downloads
H VMware vCloud Networking and Security 5.5.41 2015-04-20 Go to Downloads
E VMware vSphere Replication 61 2015-09-10 Go to Downloads
: VMware vSphere Data Protection 6.1 2015-09-10 Go to Downloads —
N
n VMware vSphere Big Data Extensions 2.2.0 2015-06-04 Go to Downloads 3
VMware vRealize Orchestrator Appliance 6.0.2 2015-09-10 Go to Downloads
VMware vCenter Operations Manager Foundation 5.8.5 2015-03-12 Go to Downloads
v Desktop
. ‘ A hhaare ERYIT AN TN W 2MME.NCAN Pt Diaanlnade : S

a. Download the VMware vCenter Server Appliance (or the Windows vCenter if you must)

fﬂ Download ViMware vSpher... X\+
€ ) & https://

y.vmware.com/group/vmware/detailsTdownloadGroup=VCE00U1 &productid=481 EJ v @ || Q Search + A W B 4 ® @ = -

VMware vCenter Server and Modules Download Now

File size: 2.668 GB
File type: iso

Download Manager

Read More

VMware vCenter Server Appliance Download Now

File size: 2.779 GB
File type: iso

Download Manager i

Read More

m

Utility to deploy Platform Services Controller in a highly available configuration - recommended to read usage documentation prior to unzipping

File size: 9.6 KB
File type: zip
Download Now
Download Manager
Read More
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i. Read and accept the entire EULA!

B Download VMware vSpher.. x| +

| € ) @ https;//my.vmware.com/group/vmware/details?downloadGroup=VC600U1 &productid=491. E1 7 €' | | Q Search ¥ & BB

VMware End User License Agreement

VMWARE END USER LICENSE AGREEMENT

PLEASE NOTE THAT THE TERMS OF THIS END USER LICENSE
AGREEMENT SHALL GOVERN YOUR USE OF THE SOFTWARE,
REGARDLESS OF ANY TERMS THAT MAY APPEAR DURING THE
INSTALLATION OF THE SOFTWARE.

IMPORTANT-READ CAREFULLY: BY DOWNLOADING. INSTALLING.
OR USING THE SOFTWARE, YOU (THE INDIVIDUAL OR LEGAL

| agree fo the terms and conditions outlined in the End User License Agreement

b. Download the ESXi ISO Image (Includes VMware Tools)

[E=N e
BB Download VMware vSpher... x| +
| € ) @ https//my.vmware.com/group/vmware/dztailsTdownloadGroup=ESXIS00UL &productld=49 E1 v & || Q Search ¥ A W B qa @& 6 = |- =
Product Downloads Drivers & Tools Open Source Custom 150s

File Information

ESXi IS0 image (Includes VMware Tools) Download Now

File size: 352.16 MB Download Manager
File type: iso

Read More

ESXi Offline Bundle Download Now

File size: 671.90 MB Download Manager
File type: zip

Read More

VMware vSphere Client Download Now

File size: 341.68 MB Download Manager
File type: exe -
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i. Read and accept the entire EULA!

fw Download VMware vSpher... X\+

€ ) @ hitpsy/

ny.vmware.com/group/vmware/details?downloadGroup=ESXI600U1 &productld=49 EJ ¥ & || Q Search 3 & T B A

VMware End User License Agreement

VMWARE END USER LICENSE AGREEMENT

PLEASE NOTE THAT THE TERMS OF THIS END USER LICENSE
AGREEMENT SHALL GOVERN YOUR USE OF THE SOFTWARE,
REGARDLESS OF ANY TERMS THAT MAY APPEAR DURING THE
INSTALLATION OF THE SOFTWARE.

IMPORTANT-READ CAREFULLY: BY DOWNLOADING. INSTALLING.
OR USING THE SOFTWARE. YOU (THE INDIVIDUAL OR LEGAL

| agree to the terms and conditions outlined in the End User License Agreement

c. Now go to Drivers and Tools

==
fm Download VMware vSpher... x\+ ol e ]
€ | @ ntips

my.vmware.com/ group/vmware/info?slug=datacenter_cloud_infrastructure/vmware E1 = @& | | Q Search = A oW oBe 4 & @ = - =

vSphere Community
Support Resources

¥ Get Free Trial

Product Downloads Dnvera & Tools Open Source Custom 1S0s
Driver / Tool Release Date

> Automation Tools and SDKs

> Driver CDs

> VMware Virtual SAN Tools, Plug-ins and Appliances
> VMware vRealize Orchestrator Plugin

> VMware Tools

> VMware vCenter Support Assistant
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i. Locate and download the binaries you want.

fﬂ Download VMware vSpher... x\+

& | @ hitps://my.vmware.com/group/vmwarefinfo?slug=datacenter_cloud_infrastructure/vmware EJ v & | | Q Search

VMware Guest SDK 9.10.0 2015-03-12
vSphere Update Manager PowerCLI 6.0 20150312
VMware vSphere CLI 6.0 2015-03-12
VMware vSphere Management Assistant 6.0 (VMA) 2015-03-12
vSphere SNMP MIBs 6.0 20150312
VMware Open Virtualization Format Tool 4.1.0 2015-03-12
VMware vCloud Suite SDK 6.0 for NET 2015-03-12
\ihiware vClond Suite SO E A far laua 2n15.02 19

- i *BE O 4

Go to Downloads
Go to Downloads
Go to Downloads
Go to Downloads
Go to Downloads
Go to Downloads

Go to Downloads

0 ta Nomlnacdc

ii. lrecommend the vCLI

fﬂ Download VMware vSpher... x\+

b

€ | @ htps://my.vmware.com/group/vmuware/details{downloadGroup=VCLIB00&productld=491 EJ + & | | Q, Search

Product Downloads Version History

=
I'!

A "B 0 40 0 = -

File Information

vSphere CLI

File size: 93 MB
File type: exe

Read More
vSphere CLI

https://my.vmware.com/group/vmware/details?downloadGroup=VCLIG00 &productld=491#

Download Now

Download Manager

Download Now

Download Manager

iii. l1recommend the vSphere Management Assistant

fm Download VMware vSpher... X\+

my wmuware.com/group/vmware/details?downloadGroup=VMAB00& productld=491 ¢ || Q Search

€ ) & nitps:

Product Downloads Version History

File Information

vSphere Management Assistant

File size: 655 MB
File type: zip

Read More

Download Now

Download Manager

cksums and SHAT ch
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Installing ESXi as a VM (Virtual Machine)

1. In Workstation, go to File > New Virtual Machine
@ YMware Workstation

Edit View VM Tabs Help

|5 Mew Virtual Machine... Ctrl+N
FE Mew Window
Open... Ctrl+0

— - AT

a. Use a Custom install

P

New Virtual Machine Wizard (3w

Welcome to the New Virtual
Machine Wizard

VMWARE What type of configuration do you want?

WORKSTATION:
PRO

() Typical {recommended)

Create a Workstation 12.0 virtual machine
ina few easy steps.

Create a virtual machine with advanced
options, such as a SC5I controller type,
virtual disk type and compatibility with
older YMware products.

< Badk Mext = ] [ Cancel
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b. Accept defaults
New Virtual Machine Wizard (3w

Choose the Virtual Machine Hardware Compatibility
Which hardware features are needed for this virtual machine?

Virtual machine hardware compatibility

Hardware compatibility: |Workstation 12,0 -
Compatible with: ESX Serwver
Compatible products: Limitations:
Fusion 3.0 - 54 GB memary -
Workstation 12.0 16 processors
10 network adapters
8 TB disk size

« Back ][ Mext = ][ Cancel ]

c. Browse

New Virtual Machine Wizard ==

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
system. How will vou install the guest operating system?

Install from:
Installer disc:

Mo drives available

@ Installer discimage file {iso):

| t] Browse...

E'-;‘ Cannot read this file.
Spedfy a different file or select a different option to continue.

(7 I will install the operating system later.
The virtual machine will be created with a blank hard disk.
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i. Locate the ESXi ISO you downloaded earlier

d. Next

@ Browse for 150 Image @
@Uv‘ » Computer + Local Disk (G:) » Users » John » Downloads » vSphere - |4y| Se o ‘
Organize = New folder = 0 @

X -

o) Music “  MName Date modified Type Size

=] Pictures

é‘ - %) VMware-VCSA-211-6.0.0-3040890.is0 9/26/20159:17 AM  Winlmage IS0

ideos
(=) VMware-ViMvisor-Installer-6.0.0.updated1-3029758 486 _64.iso 9/26/2015916 AM  Winlmage ISO 360

*d Homegroup
M Comnurter

Mew Virtual Machine Wizard

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
gystem, How will you install the guest operating system?

Install from:
Installer disc:

Mo drives available

(@ Installer discimage file (iso):

G:\Wsers\John\Downloads wSphere\WMware-vMyisor-1

Browse...

jrj YMware ESXi 6 detected.

(7 I will install the operating system later.
The virtual machine will be created with a blank hard disk.

< Back ][ Mext = ][ Cancel
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Name the VM in an extensible format and place the Virtual Machine files in a suitable location on your
computer. Remember these are the Local Disks, or DAS where your ESXi installation will be going.
Although technically a viable VMFS Volume, this is not the storage location you will want to place your

Virtual Machines if you want to configure vMotion and/or HA.

Name the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

esxi1-jbab. local|

Location:
G:Wsers\John'\DocumentsWirtual Machinesesxi1-jb-ab.local Erowse. ..
The default location can be changed at Edit > Preferences.

l < Back ][ Mext = ][ Cancel

)

-

Mew Virtual Machine Wizard @

Choose reasonable numbers here that your hardware supports.

-

Processor Configuration
Spedfy the number of processors for this virtual machine.

Processors

Mumber of processors: I?_ - I
Number of cores per processor: (3 o |
Total processor cores: 3

Mew Virtual Machine Wizard @

mj I < Back ][ Mext = ]l Cancel

)
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| am going to build a ‘typical’ cluster of 3 ESXi Hosts, so 8 GB is reasonable for a system with 32 GB RAM

available.

Memaory for the Virtual Machine
How much memary would you like to use for this virtual machine?

Spedfy the amount of memaory allocated to this virtual machine. The memory size
must be a multiple of 4 MEB.

&4 GE Memaory for this virtual machine: 8192 = MB
32 GB -
16 GB
ig: = < [ Maximum recommended memory:
3 GE 28628 ME
1GE
£17 MB @ Recommended memaory:
55 ME 4095 MB
128 MBE
&4 ME [ Guest 0S5 recommended minimum;
32 ME 4095 MB
16 MB
EME
4 ME

Mew Virtual Machine Wizard @

I < Back H Mext = H Cancel

)

-

i. Would | be better off with 2 ESXi Hosts that each had 16 GB RAM? Maybe, but | harp so often
about 3 hosts being the minimum realistic Cluster size in production, and the basic unit for all

vSphere Kits is also 3 Hosts, | couldn’t bring myself to build a 2-host cluster!
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h. Use NAT for the Management Network. One of the weaknesses of Workstation is not allowing the

configuration of multiple network adapters at the time of virtual Machine creation.

Hetwork Type
What type of network do you want to add?

Metwork connection

“1 Use bridged networking

Give the guest operating system direct access to an external Ethernet
network. The guest must have its own IP address on the external network.

@) Use network address translation (MAT)

Give the guest operating system access to the host computer's dial-up or
external Ethernet network connection using the host's IP address.

1 Use host-only netwaorking

Connect the guest operating system to a private virtual network on the host
computer.

) Do not use a network connection

Mew Virtual Machine Wizard @

I < Back H Mext = H Cancel

Use Defaults

Select I/ 0 Controller Types
Which SCSI controller type would you like to use?

I/O controller types
SCSI Controller:

BusLogic (Mot available for 64-bit guests)
@ L5I Logic (Recommended)

7 LSI Logic SAS

Mew Virtual Machine Wizard @

I < Back H Mext = H Cancel

-
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j. Use Defaults
New Virtual Machine Wizard ==

Select a Disk Type
What kind of disk do you want to create?

Virtual disk type
() IDE

i@ scsI (Recommended)

() SATA

[ < Back ][ Mext = ][ Cancel
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k. 40 GB is really generous for an ESXi installation. When physically installed on a server, ESXi can go on
flash media as small as 2 GB, but it is recommended to install on at least 16 GB flash media so blocks
may be marked unusable as they wear out. In a Virtual install, either treat it as a flash-media installation
and redirect the logs to a different location, or go with defaults.

Mew Virtual Machine Wizard @

-

Specify Disk Capacity
How large do you want this disk to be?

-

Maximum disk size (GE): 40.0 =<

Recommended size for YMware ESXi 6: 40 GB

[ allocate all disk space now.

Allocating the full capadty can enhance performance but requires all of the
physical disk space to be available right now. If you do not allocate all the
space now, the virtual disk starts small and grows as you add data to it

@ Store virtual disk as a single file;

1 Split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another
computer but may reduce performance with very large disks.

[ <ok ][ mext> ][ Cancel
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I.  Use Defaults
New Virtual Machine Wizard ==

Specify Disk File
Where would you like to store the disk file?

Disk File
COne 40 GB disk file will be created using the file name provided here.

esxi 1-jbab.local . vmdk

< Back ][ Mext = ][ Cancel ]

m. Finish

New Virtual Machine Wizard =

-

Ready to Create Virtual Machine

Click Finish to create the virtual machine and start instaling VMware ESXi
0.

The virtual machine will be created with the following settings:

Mame; esxi 1-jbab.local -
Location: G:YUsers\John\Documents\irtual Machines'esxil-b...
Version: Workstation 12.0

Operating System: VMware ESXi &

m

Hard Disk: 40 GB

Memary: 3192 MB

Metwork Adapter: MAT B
Other Devices: & CPU cores, CD/DVD, USE Controller &

[ Customize Hardware. ..

Power on this virtual machine after creation

[ < Back ][ Finish H Cancel
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2. Thisis the Standard Installer

ESXi-6.8.8-28158982881-=standard Boot Menu

ESXi-6.8.8-281589828A1-standard Installer

Boot from local disk

Automatic boot in 6 seconds...

a. The files will load to RAM

esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help > | | £ TR ¢ = i, B [ =

‘@ Home |¥| My Computer E‘ esxil-jb-lab.local

Loading ESXi installer
L}
Loading /tboot.bbn
Loading /b.bB0
Loading / jumpstrt.gz
Loading /fuseropts.gz
Loading /k.bbO
Loading /chardevs.bbd
Loading /a.bbd

Loading fuser.bdp
Loading /uc_intel .bb
Loading /uc_and.bdd
Loading /sb.vO0

Page 26 ©John Borhek 2015, All Rights Reserved

www.johnborhek.com




Page 27

b.

Building a Home vSphere Lab — Part 1
September 26, 2015

Enter

e;xll-]h-lah.\ncal-VMwarEWnrk;tatlnn == \@
File Edit View VM Tabs Help - | B SO = i I =
‘@ Home |¥| My Computer E‘ esxil-jb-lab.local

YMuare ESXi 6.0.8 Installer

Helcone to the ¥Mware ESXi 6.0.0 Installation

VYMuare ESXi 6.0.0 installs on most systems but only
systens on VMuare’s Compatibility Guide are supported.

Consult the WYMuare Compatibility Guide at:
http://uuu.vnuare .con/resources/compat ibility

Select the operation to perforn.

Use arrows to scroll

e;xil-jh-lah.\ncal-VMwarEWnrk;tatinn == \@
File Edit View VM Tabs Help ~ | & SO = e I |
‘@ Home |¥| My Computer E‘ esxil-jb-lab.local

YMuare ESXi 6.0.08 Installer

End User License Agreement (EULA)
VMHARE END USER LICENSE AGREEMENT

PLEASE NOTE THAT THE TERMS OF THIS END USER LICENSE
AGREEMENT SHALL GOVERN YOUR USE OF THE SOFTHWARE, REGARDLESS
OF ANY TERMS THAT MAY APPEAR DURING THE INSTALLATION OF THE
SOF THARE .

IMPORTANT-READ CAREFULLY: BY DOMNLOADING, INSTALLING, OR
USING THE SOFTHARE, YOU (THE INDIVIDUAL DR LEGAL ENTITY)
AGREE TO BE BOUND BY THE TERMS OF THIS END USER LICENSE
AGREEMENT (“EULA™). IF YOU DD NOT AGREE TO THE TERMS OF
THIS EULA, YOU MUST NOT DOHNLODAD, INSTALL, OR USE THE
SOFTHARE, AND YOU MUST DELETE OR RETURN THE UNUSED SOFTHARE
TO THE YENDOR FROM HHICH YOU ACQUIRED IT HWITHIN THIRTY (30)
DAYS AND REQUEST A REFUND DF THE LICENSE FEE, IF ANY, THAT

Use the arrow keys to scroll the EULA text

©John Borhek 2015, All Rights Reserved

www.johnborhek.com




Page 28

Building a Home vSphere Lab — Part 1
September 26, 2015

d. Once you have read the entire EULA, press [F11]

esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help v | & [ = 2 5 | [E

= e

‘@ Home @ My Computer Eﬁ esxil-jb-lab.local

YMuare ESXi 6.0.0 Installer

End User License Agreement (EULA)

Orders and any amendments hereto, and the Product Guide
contain the entire agreement of the parties with respect to
the sub ject matter of this EULA and supersede all previous
or contemporaneous communications, representations.

proposals, commitments, understandings and agreements.
whether written or oral. betueen the parties regarding the
sub ject matter hereof. This EULA may be amended only in
writing signed by authorized representatives of both
parties.

12.12 Contact Information. Please direct legal notices or
other correspondence to VMuare, Inc., 3401 Hillview Avenue,
Palo Alto, California 94304, United States of America. If
You have any guestions concerning this EULA, please send an
enmail to infolvnuare.con.

Use the arrow keys to scroll the EULA text

e. Enter

esxil -jb-lab.local - VMware Workstation

File | Edit View VM Tabs Help - &

[ = 2 3 | |E

o )

‘@ Home @ My Computer Eﬁ esxil-jb-lab.local

YMuare ESXi 0.0.8 Installer

Select a Disk to Install or Upgrade

= Contains a VHFS partition
# Claimed by YHuware Virtual SAN (¥5AN)

Storage Device

Capacity

Local:

Renote :
(none)
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f.  US Default (or your choice)

g. A suitable Password

YHuare ESXi 6.0.0 Installer

Please select a keyboard layout

Suiss French
Suiss German
Turkish

US Dvoralk
Ukrainian
United Kingdom

Use the arrou keys to scroll.

e;xll-]h-lah.\ncal-VMwarEWnrk;tatlnn | = || [=] |@
File Edit View VM Tabs Help - | B ST I = i i, R W =
‘@ Home @ My Computer Eﬁ esxil-jb-lab.local

Page 29

VMuare ESXi 6.0.0 Installer

Enter a root password

Root passuword:
Confirm password:

©John Borhek 2015, All Rights Reserved
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File Edit View VM Tabs Help ~ | & O 0= S| E
‘@ Home |¥| My Computer E‘ esxil-jb-lab.local
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h. [F11]
e;xll-]h-lah.\ncal-VMwarEWnrk;tatlnn ‘ = ” (=) |@
File Edit View VM Tabs Help - | B O 0 = S| E
‘@ Home @ My Computer Eﬁ esxil-jb-lab.local

YMuare ESXi 6.0.0 Installer

Conf irn Install

The installer is configured to ESXi 6.0.0 on:
npx.vnhbal:CO:TO:LO.

Harning: This disk uill be repartitioned.

i.  Wait 5-10 Minutes and press [Enter]. You can also click “I finished Installing” at this point.

esxil-jb-lab.\ocal-VMwareWorkstation [r=|[-= \@
File Edit View VM Tabs Help ~ | B O D= S| |E
‘@ Home |§| My Computer Eﬁ esxil-jb-lab.local

YMuare ESXi 0.0.8 Installer

Installation Conplete
ESXi 6.0.0 has been installed.

ESXi 6.0.0 will operate in evalvation mode for 60 days. To
use ESXi 6.0.0 after the evalvation period, you nust
register for a YMware product license. To administer your
server., use the vSphere Client or the Direct Control User
Interface.

Reboot the server to start using ESXi 6.0.0.
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esxil -jb-lab.local - VMware Workstation =] @
File Edit View VM Tabs Help ~ | B 0O D= =Z S| |E
‘@ Home |¥| My Computer E‘ esxil-jb-lab.local

VYMuare ESXi 6.0.0 Installer

Reboot ing Server

The server will shut doun and reboot.

The process will take a short time to complete.

©John Borhek 2015, All Rights Reserved
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This is what the ESXI Console should look like after reboot.

esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help | I ~ | &2 | (O Ol 0 S |

1ot Home [5] My Computer (5 esxi1-jb-lab.local

VMuare ESXi 6.0.0 (¥MKernel Release Build 3029758)

VYMuare, Inc. ¥Muare Virtuwal Platforn

2 x Intel(R) Core(TM) i7-2720QM CPU @ 2,20GH=z
8 GiB Memory

Dounload tools to manage this host from:
http://192.168.153.128/ (DHCP)
http://[feBO: :20c:29ff :Te40:af261/ (STATIC)

<F2> Custonize System/Vieu Logs

<F12> Shut Doun/Restart

To direct input to this VM, click inside or press Ctrl+G.

SuUEIidCDE@OE| D) 4

3. Now | am going to install 2 more just like it, with all settings the same, except the Virtual Machine name

Page 32

©John Borhek 2015, All Rights Reserved

www.johnborhek.com



Building a Home vSphere Lab —Part 1

September 26, 2015

This one will be: esxi2-jb-lab.local
Mew Virtual Machine Wizard @

Hame the Virtual Machine
What name would you like to use for this virtual machine?

Wirtual machine name:

esx2-jb-ab.local

Location:

G:YUsers\John'\Documents\Wirtual Machinesesx2-ib4ab. local

The default location can be changed at Edit > Preferences.

[ < Back ][ Mext = ][ Cancel ]

This one will be esxi3-jb.lab.local

Mew Virtual Machine Wizard @

Hame the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

esx3-b-ab.local

Location:

G:YUsers\lohn\DocumentsWirtual Machines'esx3-b4ab. local

The default location can be changed at Edit > Preferences.

[ < Back ][ hext = H Cancel ]

4. Now we need to log-on to the DCUI of all 3 ESXi VMs and set the IP and hostname, among other settings.
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Press [F2]
esxil-jb-lab.local - VMware Workstation ol ® =
File Edit View VM Tabs Help | I1 » | & | (O TORN B == |
@ Home @ My Computer E’;‘ esxil-jb-lab.Jocal E’;‘ esx2-jb-ab.local E;‘ esx3-jb-ab.local

VMuare ESXi 6.0.0 (¥MKernel Release Build 3029758)

VYMuare, Inc. ¥Muare Virtuwal Platforn

2 x Intel(R) Core(TM) i7-2720QM CPU @ 2,20GH=z
8 GiB Memory

Dounload tools to manage this host from:
http://192.168.153.128/ (DHCP)
http://[feBO: :20c:29ff :Te40:af261/ (STATIC)

<F2> Custonize System/Vieu Logs <F12> Shut Doun/Restart
To direct input to this VM, click inside or press Ctrl+G. OuREEDge@UE|[F 4
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esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help

| @ | O O N=E S| =

‘@ Home |¥| My Computer E‘

c. First, select Troubleshooti

esxil-jb-lab.local E‘ esx2-jbab.local

E‘ esx3-jbab.local

Authent icat ion Required
Enter an authorized login nane and password for

localhost . localdonain.

Conf igured Keyboard (US Default)
Login MHame: [ root
Passuord: [ ssmesnaens_

<{Enter> DK <Esc> Cancel

ng options (this will save you an extra log-in after reboot!)

esxil -jb-lab.local - VMware Workstation

File Edit View VM Tabs Help

=N w5

AN==N D L 0| |E

‘@ Home @ My Computer Eﬁ

System Custonmization

Conf igure Password

Conf igure Lockdoun Mode

Conf igure Management Network
Restart Managenent Networlk
Test Managenent Netuork

Netuwork Restore Options

Conf igure Keyboard

Vieuw System Logs
Vieu Support Information

Reset System Configuration

Troubleshoot ing Dptions

esxil-jb-lab.local Eﬁ esx2-jbab.local E'IW esx3-jbab.local

Troubleshoot ing Options

To view various troubleshooting mode options like Enable
ESXi Shell. Enable S5H and Restart Agents.
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Press [Enter] to enable both the ESXi Shell and SSH. You should know my feelings about SSH, and we are
going to treat our Management Network as secure, so let’s do it!

(5] esil-jb-lab.local - VMiware Workstation (= [EE |
File Edit View VM Tabs Help ~ | & | O SO I = s |

‘@ Home ] |¥| My Computer ] Eﬁ esxil-jb-lab.local ] E;‘ esx24bab.local Eﬁ esx3-jbdab.local
Troubleshoot ing Mode Options S5H Support
Disable ESXi Shell 55H is Enabled
Disable S5H
Modify ESXi Shell and SSH timeouts Change current state of SSH

Modify DCUI idle timeout
Restart Management Agents

Now select the Management network and press [Enter]

(D) esiil-jb-lab.local - VMiware Workstation =5 EER|F==|
File Edit View VM Tabs Help ~ | & | O SO m == |

‘@ Home ] @ My Computer ] E;‘ esxil-jb-lab.local ] S‘ esx2-jbab.local SW esx3-jbab.local

System Custonmization Conf igure Managenent Network

Conf igure Passuword Hostname :

Conf igure Lockdoun Mode localhost

onf igure Management Network IPv4 Address:

Restart Managenent Network 192.168.153.128

Test Managenent Netuork

Netuwork Restore Options Netuwork identity acquired from DHCP server 192.168.153.254
Conf igure Keyboard IPv6 Addresses:

Troubleshoot ing Dptions feB0: :20c :29ff :Te40:af 26/64

Vieuw System Logs To view or modify this host’s management network settings in

detail., press <Enter>.
Vieu Support Information

Reset System Configuration

Select the IPv4 Configuration and press [Enter]

(@) esia-jb-lab.local - VMware Workstation ===
File Edit View VM Tabs Help ~ | & | O O 0S| E

‘@ Home ] @ My Computer ] E;‘ esxi1-jb-ab.local ] E;‘ esx2-jbab.local E;‘ esx3-jb-lab.local

Conf igure Management Network IPv4 Conf iguration

Netuwork Adapters Manual
VLAN (optional)
IPv4 Address: 192.168.153.103
Subnet Mask: 255,255.255.0
IPv6 Conf iguration Default Gateway: 192.168.153.2
DNS Conf igurat ion
Custom DNS Suff ixes This host can obtain an IPv4 address and other networking

parameters auvtomatically if your network includes a DHCP
server. If not. ask your netuork administrator for the
appropriate settings.
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Choose an IP address that will fall within an extensible Management network and is not within the
DHCP range. Press [Enter]

esxil-jb-lab.local - VMware Workstation EI@
File Edit View VM Tabs Help ~ | & | O SO I = s |

‘@ Home |¥| My Computer Eﬁ esxil-jb-lab.local Eﬁ esx24bab.local Eﬁ esx3-jbdab.local

IPv4 Conf iguration

This host can obtain network settings auvtomatically if your network

includes a DHCP server. If it does not. the following settings nust be
specified:

( ) Disable IPv4 configuration for nanagement network
( ) Use dynanic IPv4 address and network configuration
(o) Set static IPv4 address and netuwork configuration:

IPv4 Address [ 192.168.153.101 ]

Subnet Mask [ 255.255.255.0 1
Default Gateuay [ 192.168.153.2 1

Up/Doun> Select <Space> Mark Selected <Enter> 0K <Esc> Cancel

Go to DNS Configuration and press [Enter]

esx3-jb-lab.local - VMware Workstation EI@
File Edit View VM Tabs Help - | & P O D= E

‘@ Home @ My Computer Eﬁ esxil-jbab.local E‘ esx2-jbab.local E’ﬁ esx3-jb-lab.Jocal

Conf igure Managenent Network DNS Conf igurat ion

Netuwork Adapters Manual
VLAN (optional)
Primary DNS Serwver:
IPv4 Conf iguration 192.168.153.5
IPvb Conf iguration Alternate DNS Server:

DNS Conf igurat ion Not set

Custom DNS Suffixes
Hostname
localhost

If this host is configured using DHCP, DNS server addresses
and other DNS parameters can be obtained automatically. If
not, ask your network administrator for the appropriate
settings.
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i. Setthe hostname the same as the VM name and set the DNS Server to an arbitrary low IP on this
network, where we will create DNS then Press [Enter]

esxil-jb-lab.local - VMware Workstation EI@
File Edit View VM Tabs Help ~ | & | O SOR e i, I =

‘@ Home |¥| My Computer E‘ esxil-jb-lab.local E‘ esx2-jb4ab.local E‘ esx3-jbab.local

DNS Conf iguration

This host can only obtain DNS settings automatically if it also obtains
its IP configuration automatically.

( ) Obtain DNS server addresses and a hostname automatically
(o) Use the following DNS server addresses and hostname:

Primary DNS Server [ 192.168.153.5

Alternate DNS Server [
jostname [ esxil. jb-lab.local_

Up/Doun> Select <Space> Mark Selected <Enter> DK <Esc> Cancel

j. Now go to IPv6 Configuration and press [Enter]

esxil -jb-lab.local - VMware Workstation EI@
Ele Edit View VM Tabs Help > | = | O O ND=EED|E

‘@ Home |¥| My Computer E‘ esxil-jb-lab.local E‘ esx2-jbab.local E‘ esx3-jb-ab.local

Conf igure Management Network IPv6 Conf igurat ion

Netuwork Adapters IPv6 is disabled.

VLAN (optional)
This host can be configured to support IPv6. A restart of

IPv4 Conf iguration the host will be required to enable or disable IPv6.

DNS Conf igurat ion

Custom DNS Suff ixes
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Disable IPv6 Configuration and press [Enter]

esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help ~ | & | O L

D= 23 E

‘@ Home @ My Computer Eﬁ esxil-jb-lab.local E‘ esx2-jbab.local

IPv6 Conf iguration

[ 1 Use DHCPvb

Static address #1
Static address #2
Static address #3
Default gateuway

Press [Esc]

E‘ esx3-jbab.local

This host can obtain network settings avtomatically if your network
supports Stateless Address Autoconf iguration (SLAAC) or includes a

DHCPv6 server. If it does not, static settings must be specified:

(o) Disable IPvb6 (restart required)

( ) Use dynanic IPv6 address and network configuration

( ) Set static IPv6 address and network configuration

<Up/Doun> Select <Space> Mark Selected

<Enter> 0K <Esc> Cancel

esxil-jb-lab.local - VMware Workstation

File Edit View WM Tabs Help - l%l D) 3_"

D= EH S E

‘@ Home |¥| My Computer E‘ esxil-jb-lab.local E‘ esx2-jbab.local

Conf igure Managenent Network

Network Adapters
VLAN (optional)

IPv4 Conf igurat ion

IPvb Conf iguration

DNS Conf igurat ion
Custom DNS Suff ixes

©John Borhek 2015, All Rights Reserved

E‘ esx3-jbab.local

IPv6 Conf igurat ion

IPvG is disabled.
Autonmatic

IPu6 Addresses:
fedd: :20c :29Ff :fe40 :af 26/64

Default Gateway:
Not set

This host can obtain IPv6 addresses and other netuworking
paraneters automatically if your network includes a DHCPve
server or supports Router Advertisement.
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m. Press [Y] to reboot

n.

esxil-jb-lab.local - VMware Workstation

File Edit View VM Tabs Help -~ | & B O 0 E S| E

‘@ Home @ My Computer Eﬁ esxil-jb-lab.local E‘ esx2-jb4ab.local

E‘ esx3-jbab.local

Conf igure Management Network: Confirm

You have made changes to the host s management netuwork.

Applying these changes may result in a brief network outage.
disconnect remote management software and affect running virtual
machines. In case IPv6 has been enabled or disabled this will
restart your host.

Apply changes and reboot host?

<¥> Yes <N> NHo {Esc> Cancel

esxil -jb-lab.local - VMware Workstation

File Edit View VM Tabs Help v | & P O 2 | E

‘@ Home @ My Computer Eﬁ esxil-jb-lab.local E‘ esx2-jbab.local E‘ esx3-jbab.local

Restart Host

Restart in progress...

5. Now do the same to the other two ESXi Hosts, except use unique Hostnames and IP addresses!
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Coming soon.....
e In Part two, we will create DNS (which is a prerequisite for installing vCenter in any form) and then we will install
the VMware vCenter Server Appliance
e In Part three, we will create shared storage using Openfiler as an iSCSI SAN
e In Part four, we will configure vSphere Storage, Jumbo Frames, Port Binding and All, and then migrate our VMs

to the SAN
e In Part five, we will configure a vSphere Cluster for DRS and HA, then test those services
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